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01.0 Introduction

Thank you for purchasing a ProJet™ 3-D Printer System. We pride ourselves in our ability to offer customers three dimensional modeling
solutions. The 3D Systems team is confident your system will provide many years of service.

1.1 About this Guide
1.2 Copyright

1.3 Useful Documents
1.4 What's Inside

1.5 Features

1.6 Packaging

1.1 About this Guide

This guide describes how to create finished parts using the ProJet™ 3-D Printer. It also provides user's with an understanding of key features,
system requirements, and operating procedures.

Should additional questions arise, consult Section 11.0 Troubleshooting of this guide. If further assistance is required, contact 3D Systems
Technical Support or visit http://www.3dsystems.com/ Web Site.


http://www.3dsystems.com/

1.2 Copyright

© 2012 by 3D Systems, Inc. All rights reserved. This document is subject to change without notice. This document is copyrighted and contains
proprietary information that is the property of 3D Systems, Inc. The licensed user, in the name of whom this document is registered (the "Licensed
User") does not have the right to copy, reproduce, or translate this document in any way or to any media without the prior written consent of 3D
Systems, Inc. No copies of the document may be sold or given to any person or other entity.

ProJet™ is a trademark and the 3D logo and VisiJet® are registered trademarks of 3D Systems, Inc.

Improvements

3D Systems may (but shall not be obligated to) make improvements to this document from time to time. However, the Licensed User
acknowledges that at any time after the expiration of the date of issuance, 3D Systems may institute a periodic charge or fee payable by the
licensed user in return for ongoing receipt of improvements. It is the responsibility of the licensed user to provide 3D Systems with current
information as to its name and address. The licensed user also undertakes to notify 3D Systems promptly in the event that it considers any of the
data contained in this document to be incomplete or erroneous in any respect, in connection with licensed user's particular use or generally.

FCC Notice

This equipment has been tested and found to comply with the limits for a class "A" digital device, pursuant to Part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment.
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference
in which case the user will be required to correct the interference at their expense.

Changes or modifications not expressly approved by 3D Systems could void your authority to operate this equipment.

Radio Frequency Transmission

This product generates 13.56 MHz using an Inductive Loop System as a Radio Frequency Identification device (RFID). This RFID device
complies with the requirements specified in FCC Part 15, Industry Canada RSS-210, European Council Directive 99/5/EC, and all applicable local
laws and regulations.

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

The device referenced in this guide contains transmitter, FCC ID: 2ADGF-SKTKM1 IC: 12666A-SKTKM1. Access to the transmitter for service
technicians is available through common enclosure access methods including use of common tools and removal of covers.

Note: Changes or modifications to this equipment not specifically approved by 3D Systems may void the user's authority to operate this
equipment.

Limitations of Warranty and Liability

This information is provided by 3D Systems for the convenience of its customers. It is believed to be reliable, but NO REPRESENTATIONS,
GUARANTEES, OR WARRANTIES OF ANY KIND ARE MADE AS TO ITS ACCURACY, FITNESS FOR A PARTICULAR USE, OR THE
RESULTS TO BE OBTAINED THEREFROM. The information is based in whole or in large part on laboratory work and does not necessarily
indicate performance in all conditions. Notwithstanding any information provided by 3D Systems or its affiliates, the customer remains fully
responsible for determining which federal, state, or local laws or regulations, or industry practices are relevant to activities in which it engages, as
well as assuring that those laws, regulations, or standards are complied with under actual operating conditions, and 3D Systems undertakes no
responsibility in these areas.

IN NO EVENT WILL 3D Systems BE RESPONSIBLE FOR DAMAGES OF ANY NATURE, INCLUDING SPECIAL OR CONSEQUENTIAL
DAMAGES, RESULTING FROM THE USE OF OR RELIANCE UPON THIS INFORMATION. THE CUSTOMER ASSUMES ALL RISK
RESULTING FROM THE USE OF THIS INFORMATION. Customer use of the materials that follow is an acknowledgment of its agreement to the
foregoing. Any customer not wishing to be bound should return this material to 3D Systems. Nothing contained herein is to be considered as
permission, recommendation, nor as an inducement to practice any patented invention without permission of the patent owner.

1.3 Useful Documents

The documents listed listed in this section, will assist you in finding solutions to questions that may arrise during operation. To access documents,
click on their title.

ProJet™ 3-D Modeling Client Online Help: Run the client software, select Help > Help Topics in the modelers window or in Build Preview window
to launch the client online help. The online help provides detailed instructions on how to use the client software to setup, run, and manage build
jobs.

ProJet 5000 Quick Reference Guide.pdf: Download the quick reference for advice on how to operate the control panel functions, how to load /
remove material bottles, and how to run a test build.

VisiJet® Material Handling and Post-Processing Guide: This document has everything needed to guide you in safely handling and disposing of
VisiJet® material, including relevant regulatory guidelines for material disposal worldwide. It also provides information on how to clean parts once
the build process is completed.

Projet™ 5000 Facility Requirements Guide. This guide provides the dimensional data that is required when the 3D System's authorized Field
Service Engineer or your authorized servicing reseller installs the printer.

VisiJet® Material Safety Data Sheets (MSDS's). Ensure that everyone who handles VisiJet™ materials is familiar with MSDS's and follows the
safety guidelines. To obtain extra copies of the MSDS / SDS, click on http://www.3dsystems.com/services/materials/index.asp. to download
MSDS/SDS.


http://3dWorks.3dsystems.com/download/attachments/65732694/ProJet+5000+Quick+Reference+Guide.pdf?version=1&modificationDate=1328884567033
http://3dWorks.3dsystems.com/display/VJHG/Table+of+Contents
http://3dWorks.3dsystems.com/pages/viewpage.action?pageId=35291145
http://www.3dsystems.com/services/materials/index.asp

1.4 What's Inside

Safety: Read prior to handling VisiJet® materials or operating the printig system. The safety sections inform you of handling the material properly
and avoid damage and injury when operating the printer. For more detailed material safety information, refer to VisiJet® Material Handling Guide.

System Requirements: Provides electrical requirements prior to plugging in your modeler for operation. For more detailed facility requirements
information, see ProJet™ 5000 Facility Requirements Guide.

Familiarization: Provides a brief description of the printing system.

Printer Setup: Provides information on preparing the 3-D printer for builds using the software, and how to send test and demo builds to the
printer from your computer. Also; refer to your online help for software instructions.

Operations: Describes loading and running the printer; start and stop build jobs; monitor and control build jobs; unload build parts and disposing
waste material.

Error Messages: Defines error messages you may see on the printer's LCD and provide the actions to take to correct the problem.
Finishing:Provides information on finishing models.

Maintenance: List printer maintenance procedures which must be done to ensure high part yield and low printer down time. Semi-annual
preventive maintenance requires a certified 3D Systems Technical Support Representative.

Troubleshooting: If problems occur with the printer, look for solutions in this section first. It describes some common problems which can occur
and suggests corrective actions.

Technical Support: List of contact numbers of sale and support personnel for your printer system.

1.5 Features

Dual Mode

The new ProJet™ 5000 3-D Production System, features two build styles to meet a variety of model making applications.

® The High Definition (HD) Mode allows the
user rapid model making capability on a full
platform size of 550 x 393 x 399 mm, (21.6 x
15.4 x 15.7 inches), (x,y,z). This mode
produces high quality parts for concept models,
verification designs and patterns for casting.

[ 1 ) ) | R ] ] L ) 8 e |



http://3dWorks.3dsystems.com/display/VJHG/Table+of+Contents
http://3dWorks.3dsystems.com/pages/viewpage.action?pageId=35291145

® The Ultra High Definition (UHD) Mode allows e B Vo Teie e
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parts with exceptional surface finish and
superior accuracy. The platform size in UHD
mode is 550 x 393 x 399 mm, (21.6 x 15.4 x
15.7 inches), (x,y,z). Models build in UHD mode
are typically used for show models, fit testing
and direct manufacturing using patterns for
investment casting of fine detailed and high
precision components.

Part Stacking and Nesting

The new ProJet™ 3-D Production System, features part stacking and nesting capability in both build modes.

® Stacking: The user can now utilize the entire g e
build volume by stacking parts vertically in the a0 ) A S| 268 S EP BRI Smain. et sletetein )
z-direction to fill up the entire build envelop with
parts. The user can control the space between
layers to minimize support material usage and
build time. Now, hours can be saved by
stacking parts and submitting single, long builds
overnight and weekends




® Nesting capability allows parts to be placed
within the boundaries of one another but not
overlapping the part structure itself. Nesting
also allows the user to fully utilize the Y and X
axis of the build platform.

NESTING

1.6 Packaging

Packaging

Do not damage or discard any packaging materials or crate. If the printer needs to be returned to the manufacturer, it should be shipped in it's
original packaging and crate. If other method of packaging is used, the customer will be responsible for any shipping damages that may occur.

Only Certified/Qualifed Service Personnel can install the 3-D printer.

02.0 Safety Symbols & Definitions



This symbol designates the accompanying texts or figures as either a CAUTION or a WARNING.

® Caution: Indicates something may happen that could cause loss of data, damage to equipment, or personal injury.
®* WARNING:Indicates a hazard to both equipment and personnel that may be in the immediate area.

This symbol is used to warn of the presence of potentially HAZARDOUS VOLTAGE. High voltage electricity is accessible in the
vicinity of this sign or behind the access panel. High voltage can cause severe burns or death. Access panels are for service only
and should be opened only by certified service personnel or trained maintenance personnel.

Invisible UV radiation is accessible in the vicinity of this sign or behind the panel. Radiation can cause eye injury. Access panels
are for service only and should be opened only by certified service personnel. Use UV radiation eye and skin protection when
servicing with "bypass engaged.”

A hot surface is accessible in the vicinity of this sign or behind the access panel. Avoid contact. Hot surfaces can cause severe
burns. Access panels are for service only and should be opened only by certified service personnel or trained maintenance
personnel.

Harmful Irritant Warning: Indicates that skin or eye irritation could result while exposed to a chemical composition.

When accompanied by the word "NOTE", the text and symbol are meant to call attention to a practice whose implementation can
save time or prevent subsequent inconvenience to the user.

03.0 Safety Guidelines

Before using the printer, your company should have a safety program in place. The safety program should:

® Label and point out hazardous equipment, materials, and procedures.

® Explain what to do in case of an emergency.

® Provide information about hazards of equipment and materials in the form of Material Safety Data Sheets (MSDSs). The MSDSs are
provided with all materials supplied by 3D Systems.

® 3.1 General
® 3.2 Electrical
® 3.3 Ultraviolet (UV) Light

3.1 General

The printer is designed with built in safety features. Improper use can lead to malfunctions that can cause injury to personnel. To prevent unsafe
operation, the printer will automatically shut down if unsafe conditions are detected.

Follow these safety guidelines when operating the printer:

Read and follow all printer instructions.

Follow all safety rules and heed all cautions and warnings in this guide.

Do not attempt to open chamber door while build in progress.

Do not use any material without reviewing the Material Safety Data Sheets (MSDS).

Dress power and communication cables behind printer to prevent tripping.

Do not attempt to access, service, or adjust printer components. Do not attempt to perform any maintenance procedures unless
specifically trained to do so.

® Do not operate without all safetys and guards in place and functional.

Operators are trained to operate system and perform all necessary tasks to create a part.

Certified service personnel are those who completed the 3D Systems service training package and were certified to perform service tasks.
Certification may occur at different levels, and service providers should only perform tasks they are authorized and certified to complete.

Do not ignore warning signs posted during printer service operations.

If an error message appears on the printer's LCD refer to Section 10.0 Error Messages within this guide before resuming operation.



To prevent potential skin-irritation and sensitization due to contact with waste material, follow all guidelines within Build Material Safety.

To prevent pinch and crush injuries to the hand, use caution when replacing platform inside the build chamber.
3.2 Electrical

WARNING: Hazardous voltage exists inside the printer. Injury or death from electrical shock can result if you remove the
printer's external panels. Panels should only be removed for service by trained and certified 3D Systems Technical
Support personnel or your servicing reseller.

To prevent electrical shock, the printer will not operate unless external panels are installed. Verify facility's electrical
service rating before connecting power to the printer.

NOTE: This equipment is not designed for connection to an IT system.

3.3 Ultraviolet (UV) Light

CAUTION: Hazardous UV radiation exists inside the printer's build chamber during build job. Eye injury or blindness
can result if the chamber door is opened while a build job is in progress. If build job is running, abort build job
before attempting to open chamber door. To prevent eye injury, ultraviolet (UV) light inside the chamber will not

operate when chamber door is open. When closed, the chamber door keeps UV radiation from escaping. The
chamber door remains locked if build job is paused.

04.0 Part Material Safety

Users of the printer should be informed of potential hazards of part material prior to working with a printer, or performing duties which may result
in exposure to uncured part material, such as removal and disposal of empty material bottles and / or waste bag.

SYSTEMS

Build Materds!
VisiJet® MX
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VisiJet® MX
Build Material | waste Bag

4.1 Disposal

4.2 Health Hazards

4.3 Material Handling

4.4 Personal Protection Equipment
4.5 Regulatory Information

4.6 Spilled VisiJet® Material

4.7 Waste Removal

4.8 Material Storage

4.1 Disposal

Disposal of fully cured part material produced by the printer is not subject to regulations of any known agency worldwide. Disposable bag filled
with VisiJet® support and part materials and the material bottles may be disposed of according to your local codes.

Uncured part material waste is classified as regulated, and in some areas hazardous requiring special packaging, transportation, and disposal.
The disposal of partially cured or uncured part material must comply with all local, state, and federal environmental safety regulations. Applicable

part material "waste" include bottles (empty or full) and waste bag. Any cleaning materials used to clean up spilled uncured part material should
be disposed of in compliance with local, state, and federal environmental safety regulations.



]
F
-
"
>
.

Build Material

VisiJet® MX

VisiJet® MX S—

Build Material - Waste Bag

To find out facility disposal requirements, contact a local waste disposal provider. (Local environmental regulatory agency should have a list of
qualified providers.) You will need to give disposal service provider a copy of the part material MSDS, and possibly other forms included in the
Appendix of your VisiJet® Material Handling Guide, such as Waste Profile Worksheet and SNUR (Significant New Use Regulation - U.S. only).
A report will be provided, indicating disposal requirements, as well as a quotation for regularly scheduled pickups. If assistance is needed locating
a waste disposal provider, or completing a waste disposal form, contact 3D Systems;Technical Support Hotline.

3D Systems assumes no liability or responsibility for proper disposal of uncured part material. Proper disposal of uncured material is the sole
responsibility of the user.

4.2 Health Hazards

Irritant

Caution: Uncured VisiJet® part material is Any chemical may exert harmful effects if contacts or enters the body. VisiJet® part material is
a sensitizer. Skin or eye irritation could a sensitizer and irritant.

occur when exposed to the chemical
composition of the material.

Skin Sensitization: Uncured VisiJet® part
material is a sensitizer. Skin or eye irritation
could occur when exposed to the chemical

composition of the material.

Uncured material is a sensitizer, and can cause allergic reactions if contacts skin without
protective gloves. Refer to personal protection equipment for more information. To avoid

sensitization, do not allow uncured material to contact skin. Consult the MSDS for specific
information about the sensitization potential.

Ingestion: Uncured VisiJet® part material is

Uncured material is toxic if ingested. Uncured material must not be present where food and
toxic if ingested.

drink are *stored, prepared, or consumed and not ingested. After handling materials, wash
hands with soap and water before consuming or preparing food.

Inhalation: Under normal operation, inhalation is not an expected route of entry.

Contact With Uncured Material

Employees should be alerted to clean and rinse off any contacted surface promptly in order to prevent further contamination. Ensure a convenient
washroom location is provided with access to soap, water, and disposable paper towels.

Handling Finished Parts

Finished (cured) parts can be handled or disposed of the same as standard household plastic products. VisiJet® parts are not recyclable. VisiJet®
materials are not intended for, and cannot be used for medical implant, or food or drink handling applications.




Exposure control
The printer has a variety of built-in engineering controls which are designed to prevent operator exposure. Do not try to change or disable these

controls.
Appropriate hygienic practices should be followed, including washing with soap and water before meals, breaks, smoking, applying cosmetics,
using toilet facilities, and after work.

4.3 Material Handling

Emergency (MSDS)
Chemtrec USA (800) 424-9300; Europe +1-703-527-3887

Packaging Inspection

VisiJet® materials are supplied in bottles. These bottles are packaged with cardboard packing material inside the shipping carton. Upon receipt of
material shipments, inspect cardboard carton exterior for signs of damage and leakage. If leakage is observed, DO NOT open carton, contact 3D
Systems'Technical Support Hotline. If no leakage is observed, store shipping carton until material is used. (VisiJet® MX is depicted in the photo)

Building

If uncured material is observed on the part or platform after build, this is an abnormal condition, and is an indication the printer requires servicing
by 3D Systems. Assume any liquid or paste-like material is part material. Do not directly touch uncured part material without protective gloves.
Discontinue use of the printer, pending service by a 3D Systems Technical Support Representative or your servicing reseller.

Flammability and Combustibility

Do not expose materials to heat at or above 230°F (110°C), flames, sparks, or any source of ignition. (Though the U.S. Department of
Transportation does not consider VisiJet® materials a "flammability hazard," they do classify them "combustible" based on flash points.) For more
information on VisiJet® material flash points and combustibility, see VisiJet® Material Handling Guide.

4.4 Personal Protection Equipment

Skin Protection: When removing and disposing of the part material bottles and waste bag, exposure to uncured part
material may occur To prevent contact, wear chemically resistant protective gloves - nitrile or neoprene gloves are
recommended. Do not use Latex gloves.
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Eye protection: In the event of a leak or spill of uncured part material, wear safety glasses with side shields to provide
eye protection.

Respiratory protection: Because of the printer's built in engineering controls, respiratory protection is not necessary
during normal operation. A NIOSH-approved (or equivalent) dust mask is recommended when dry sanding cured
material parts.

4.5 Regulatory Information

VisiJet® support material has no known regulatory requirements.

In the U.S., uncured material is subject to special EPA disposal regulations and record-keeping requirements. "Uncured VisiJet® material"
includes any part material bottles (empty or full), and waste bag; about half of which is uncured part material. For complete disposal regulation
details, see the VisiJet® Material Handling Guide.

In the U.S., the following disposal records must be kept for five years after the date of disposal:
® The quantity of part material received (new or "virgin").
® The name and address of the shipping location (the "responsible party" - generally your waste disposal service provider).

® The quantity of part material shipped (disposed). For further information, see the VisiJet® Material Handling Guide.

For assistance, contact 3D Systems Technical Support.

4.6 Spilled VisiJet® Material

Spills of material are HIGHLY UNLIKELY, and should NOT occur in normal operation of the printer.

The first priority is to protect users from inadvertently touching material. Spills of support material can be cleaned without use of protective gear,
and disposed of as office trash. Handling uncured part material requires use of gloves and other personnel protective equipment to ensure no
direct contact with uncured part material. If you don't know which material it is, assume it to be uncured part material, and handle accordingly -
with the recommended personal protective equipment.

Promptly clean up spilled material, dispose of clean up materials and waste material per local regulatory requirements. Discontinue use of the
printer, and contact 3D Systems Technical Support for a service visit to determine and repair the source of leakage.

Small spills of uncured liquid part material can be cleaned up using disposable towels, non-reusable rags, or absorbing materials such as
sawdust, clay, diatomaceous earth, or activated charcoal. If spilled material is hot (liquid), wait until cools and gels before wiping up. After wiping
up the spill, wipe surface with denatured or isopropyl alcohol and clean thoroughly with soap and water.

Consider avoiding placement of the printer over carpeting, or consider use of barriers to avoid the possibility of carpet damage if inadvertant spills
were to occur.

Advise service provider involved, of the spilled material, and provide MSDS and other material information prior to contact with the material.
Advise them of disposal requirements for part material and clean-up products if part material (uncured) is the spilled material. Use of heat above
65°C (149°F) may prove helpful in removing spilled part material from carpet.

Tools contaminated with part material should be cleaned prior to reuse. Solvents such as denatured alcohol or Iso-Propyl Alcohol (IPA), are

normally required to clean equipment and tools. Wash with soap and water to remove any traces of excess part material or solvent. Contact
solvent suppliers for information on proper handling of solvents if used for clean-up.

4.7 Waste Removal

. Caution: Uncured part material is a sensitizer. Skin or eye irritation could occur when exposed to the chemical composition
of the material.

Wear protective gloves Before removing any waste product from the printer. Be careful not to spill, drop, or expose others to these materials -
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particularly part material bottles or waste bag. Dispose of all waste material appropriately per local regulatory requirements.

Open waste drawer.

Remove the waste bag from the waste bag holder by pushing the top frame in and rolling the bag that is lap over the holder upward.
Seal bag and dispose according to your local regulatory guidelines.

Replace new waste bag by reversing the previous process. Close waste drawer after waste bag is installed.

4.8 Material Storage

PART MATERIAL SUPPORT MATERIAL

VisiJet® MX VisiJet® S300

Shelf life- 1 yr. Shelf life- 2 yr.

Climate- Cool, dry area with adequate ventilation Climate - Cool, dry area with adequate ventilation

Temperature Range- 60°F (16°C) to 80°F (27°C) Temperature Range- 60°F (16°C) to 80°F (27°C)

Maximum Storage Temp- 95°F (35°C) Maximum Storage Temp- 95°F (35°C)

Environmental Conditions- No direct sunlight, heat, flames, or UV Environmental Conditions - No direct sunlight, heat, flames, or UV

energy. energy.
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Support Material

NOTE: For optimal results, keep stored cartons closed, and do not open until bottle is ready for use.

Always check bottle's expiration date before loading. Do not load bottles into printer if they are about to expire. When printer detects an expired

bottle, it aborts the build and rejects the bottle if the expiration date has expired for support material or more than one year past the expiration
date for part material.

NOTE: When storing material bottles that have been used but still have materials in
them, do not lay the bottles on their side when storing; stand bottles in the upright
position. Also, in the case where used bottles with materials are removed from the MDM
and are still warm, it must be stored with the cap vented. If the warm bottle is not
vented, the wax will contract during cooling and the bottle's bottom may become flat
which will prevent reengagement in the MDM.

Support material bottles must be loaded in the left side material delivery module. The part material bottles must be loaded in the right material

delivery module. Before loading material bottles into the printer, inspect bottles for signs of damage or leakage. Do not load a damaged or leaking
bottle. Dispose of them according to local regulations.

05.0 System Requirements

Power Rating

Country Voltage Frequency Amps (A) Phase Power Cord

France 200-240 VAC 50 Hz 15A single | P/N 21684-101-XX
Germany 200-240 VAC 50 Hz 15A single | P/N 21684-101-XX
Hong Kong 200-240 VAC 50 Hz 15A single  P/N 21684-111-XX

Italy 200-240 VAC 50 Hz 15A single = P/N 21684-101-XX



Japan 115-127 VAC
194-240 VAC
Switzerland 200-240 VAC

United Kingdom | 200-240 VAC

USA 115-127 VAC
194-240 VAC

50/60 Hz 20 A single
50/60 Hz 15A single
50 Hz 15A single
50 Hz 15A single
60 Hz 20A single
60 Hz 15A single
Shielded

Power Cord

Ethernet Cable

P/N 23417-802-XX
P/N 316262-00

P/N 21684-107-XX
P/N 21684-105-XX

P/N 23417-802-XX
P/N 316262-00

06.0 Familiarization

The ProJet® 3-D Printer is a multi-jet-printing type system. The solid imaging printer produces plastic prototype parts from 3D solid
Computer-Aided Design (CAD) and through the ProJet Client Software. The parts are generated in a rapid prototyping (RP) environment. The

primary features are the operator panel, build chamber, material delivery systems, and waste drawer.

Support
Material
Delivery
Systems

The three dimensional solid parts built by the printer consist of two materials (support material and part material). The support material is a wax
based material providing adhesion to build platform, as well as, providing material used to produce supports required to build the model.

Build S—

Material
Delivery
Systems

(" Operator Panel

LIGHT On/Off

Confirm

LCD Display

Confirm
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| VisiJet® 5300 |
| Build Material

| Support Material_j

The part material used to build parts is an ultraviolet (UV) curable material. After a layer of material is deposited in the build chamber, the part is
exposed to a UV flash lamp. The UV energy is absorbed by the material converting the liquid build material to a solid polymer. When the build is
complete the part (consisting of the two materials) is adhered to the build platform by means of the support material.

The material is delivered in a 2kg. plastic bottle and are placed in the machine's material delivery module (MDM). Support material modules are
located on the left side of the machine and the part material modules are located on the right side of the machine.

Waste Path, HMS Cleaning & Planerization

A vacuum system draws the waste from the head maintenance and planerization operations to a waste tank. The waste tank is periodically
discharged into a waste bag for disposal. A curing light resides above the bag to cure the top layer of material in the bag.

After the build is complete, the platform and the part are removed. A secondary operation, known as finishing, is required to provide a finish/clean
part. For cleaning and finishing instructions, refer to the VisiJet® Material Handling.

6.1 System Functions

The instructions use special text formats to highlight menu commands, keys on the keyboard, operator panel buttons, and text on the operator
panel display.

Menus: | Menu names and menu options are capitalized in boldface text. Instructions for selecting menu options will appear as described:
"Select Menu>Option." This means "select (click or highlight) the Menu, then select Option on the menu.

Keys: Keyboard key names are capitalized; for example, "Press the Enter key."

Buttons: = Command buttons on the modeler's operator panel are in boldface upper case text; for example, "Press the ONLINE button.” The
command buttons are: MENU, LIGHT, PAUSE, ONLINE, YES, NO, and ABORT.

Display @ Text on the printer's display appears in uppercase in this guide; for example, "When the display shows PAUSE JOB? Y/N, press

Text:: YES.

Confirm “YES” Confirm “NO”
LIGHT On/Off LCD Display

Online/Offline
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07.0 Printer Setup

To prepare and build part files, connect your PC and printer to the network. For additional information refer to the Client Workstation
Requirements in the Facility Requirements Guide.

Component Type Software Requirements

PC XP Professional, Vista, Windows 7

® 7.1 Power on Printer
7.2 Install & Remove Material Bottles and Build Platform
® 7.2.1 MDM Installation
7.3 Install and Run ProJet™ 3-D Modeling Client Software
7.4 Create STL File(s) to Build
7.5 Submit Test Build
7.6 Build Demo

7.1 Power on Printer

Warning: Read and follow all safety guidelines in Electrical Safety. Ignoring these guidelines could result in death, bodily
injury, or printer damage due to electrical shock or fire.
Confirm power source is appropriate for use prior to connection.

Warning: Verify printer's rear panel power switch is OFF. When connecting the power with switch on can damage the
printer and cause bodily injury or death due to sudden, unexpected mechanical motion.

P> B>

1. Plug printer's power cord into printer's rear panel socket. Plug power cord into a grounded power outlet.
2. Place switch on the rear of printer to the ON position.

3. Wait 4 hours for printer to warm up before pressing ONLINE to start a build job.

Jobs can not be submitted to the printer while it is warming up.

|

Shielded
Ethernet Cable

Power Cord

7.2 Install & Remove Material Bottles and Build Platform

Material Bottles
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The printer has up to four material delivery modules for part materials and up to four material delivery modules for support materials. The support
delivery modules are located on the left side and the part delivery modules are located on the right side of the printer. Each delivery module holds
one (1) bottle of material.

NOTE: Before handling the part material bottle, read the Material Safety Data Sheet (MSDS.

STEP1. &2 STEP 3.
1. Unpack bottles and the MSDS/SDS Sheet from cartons.

2. Open left and/or right material delivery doors. Pull material
delivery module (MDM) handle down and out to open.

3. Install bottle into the MDM; press bottle down until a click
sounds.

4. To ensure that bottle is locked in place, gently pull on bottle. If
bottle is loose, press bottle down to ensure it is secured in MDM.

5. Loosen bottle cap 1/2 to 3/4 turn counterclockwise to allow the
bottle to vent.

6. Before removing bottle from the MDM, re-tighten bottle cap to
prevent spillage. To remove bottle, open material delivery
module and press release latch down and lift bottle out of
module.

e

STEP4. & 5.

STEP 6.

Build Platform
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. Ensure that the corner guides on the backside of
platform are clean and free of debris. If debris exists
when installing, the platform guides will not lock into
the platform elevator.

. Clean platform elevator and platform using a lint free
cloth and Isopropyl alcohol. When cleaning platform,
clean the front and back sides.*

. Lift build chamber door; place platform with corner
guides and pads facing down onto the platform
elevator. Seat onto elevator. The corner guides will
affix the platform to the elevator and if properly
installed, platform will not move.

. Ensure platform sits squarely on the elevator and is
firmly located by the corner guides. Use caution not
to drop the platform or hit the printhead.

. Close build chamber door and press ONLINE.

. To remove platform, lift from the sides; pull up and
out from the platform elevator.

7.2.1 MDM Installation

Please click on the link to access the installation instructions: MDM Installation.pdf

S

window appears.

Clean with a lint free cloth
and Isopropyl alcohaol.

STEP2

7.3 Install and Run ProJet™ 3-D Modeling Client Software

NOTE: Before installing software, ensure network and PC meet Printer Setup requirements.

1. Load the 3-D Modeling Client Software from CD packaged with the printer's accessories kit. An autorun file on the CD will
automatically load when CD is inserted into ROM drive of the computer. If installation program does not start when loaded, select and
run Setup.exe from the root directory of the ROM drive.

2. After successfully installing software, select Start from the Program menu and then select >3-D Modeling Client icon. The printer
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E Client Manager - 3-D Modelers

File ‘Wiew Help

add madeler

3. Power up printer as described in 7.1 Power on Printer. Establish a network connection between printer and PC.
4. Build jobs can only be submitted to printers that have icons in the window. To create an icon for a printer, click Add printer icon (or
choose File > Add 3-D modeler), the "Add Printer" window appears, prompting to choose the printer's IP address from list of available

printers.
E Client Manager - 3-D Modelers

File ‘Wiew Help

add modeler

5. Select the IP address for desired printer, click OK *NOTE: The IP address is located in the . The client software prompts for a printer
name. After entering a name, an icon for the printer appears in the 3-D Printers window. Once an icon exists, click on it to add files for a
build job, preview build job, summit a build job, or manage a build job in progress.



Add a 3-D Modeler 3

Enter 3-D Modeler IP address:

Available Modelers:

MName IP Address Type

< | 2

Refresh | Cancel

6. After the printer is added, click on the icon in the 3-D Printer window or choose File > Open 3-D Printer to submit build jobs to the
printer, or manage build jobs in it's queue. If the printer icon has a red lightning bolt, your PC is not communicating with the printer. Jobs
cannot be submitted to the printer until communication is restored.

Submit (%]

[ Job Mame: ]

Select Files... I Hemove Files 1 Options ... ]

Job Seale [%]:

I ame ] Extents D_‘_“‘
INZ2=3N2x05220n 12

C:MProgram Filezh30 Spztem...

Copies:

|

2 [ Preparation Orly

Presview... ] | Subrnit | Cancel I

UHD mode is cumently selected. Click Options to change.

7.4 Create STL File(s) to Build

The printer builds 3-D models from files using industry-standard .STL (STereoLithography) format. Most popular 3-D modeling CAD software
packages can save files in STL format. Sample STL files are in the 3-D Modeling Client Samples folder.



Click the Submit Icon
Click the Select Files...

Doutl)le Click on Sample.stl file

DA Dro le n 3
Fi [ e o He
4|2 slalk olelolel @l
fobNart | End Time
Job Name: ] defaul
Select Files... | dmove File | Options ...
Name Y AD
<l aok in: I@Samples j - & B~
For Help, <
UHD

File name: |Sample,st| IV File Preview
Filess of type: ISTL Files (*.stl) j Cancel

7.5 Submit Test Build

Press MENU,scroll up or down until TEST BUILD is high lighted in the LCD Display.

LCD Displa

Press YES. The message PLATFORM CLEAR DOOR CLOSED? Y/N scrolls across the display. # Press YES if the platform is clear and the
chamber door is closed, otherwise press NO.



LCD Display] [ No |

It is recommended to submit a Test Build prior to each build job.

[

7.6 Build Demo

1. Press MENU, scroll to highlight BUILD DEMO. # Press YES on Operators panel; the system displays PLATFORM CLEAR? Y/N. #
When platform is clear, press YES. The printer starts demo build job.
Scroll up

. . Pause
Light- on/off LCD Display job Online/Offline

Abort job Confirm YES Confirm NO Menu Scroll down

08.0 Operations
This section provides information on previewing, saving, submitting, and managing jobs through the printer's operator panel menu and 3-D

Modeling Client Software. In addition this section describes how to remove the build platform, how to empty the waste drawer and how to shut
down the printer.

Make certain the printer is *Off-Line during the job submittal process. Place the printer on-line after the job is submitted.
i ik
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8.1 Print Preview Overview

8.2 Save a Build Job

8.3 Submit a Build Job

8.4 Manage Build Jobs

8.5 Printer Status

8.6 Empty Waste Drawer

8.7 Shutdown Printer

8.8 Remove Part from Build Platform



® 8.9 Shrink Compensation for VisiJet® MX Part Material

8.1 Print Preview Overview

Click on theicon to view the functionality of the print preview icons along with their individual video clip.

¥ Print Preview for 3-D Modeler - 3-D Printer Print Preview

Fle Edt View Tooks Help

8l%| oS == skl alel ols] 2126 ¢fF 2I8|9@ @@l 08 | mls|na|eloy < e|w|w|wlD|s]
|5

Units: inch Prolet 5000 30 Systems, Inc.

L% "

Preview a build job before submitting.
Preview jobs before submitting them to the printer.

1. Click Preview...button on the Client's Submit dialog box. At least one part must be added for build in the Submit dialog box before able

to preview.
—
Submit %]
[ Job Mame: I
Select Files... | HemoveFiles I Options ... |
I Job Scale [%]:
M ame Estents
I vI 25
C:5Program Filesh3D Swetem... 3112 #3112 20522 in |
Copies:
= I
< il I [ Preparation Only
Presie. .. | | Subrnit I Cancel |
| IJHD mode iz cunrently selected. Click Dptions to change.




2. Highlight a Job Name in printer's Info window, click Preview button or choose Job > Preview.

When the preview window opens, STL files can be added and removed, parts can be changed, rearranged, and submitted. The modified jobs can
be sent directly to the printer's queue.

® 8.1.1 Add Part

® 8.1.2 Part Selections, Translation,Rotation
® 8.1.3 Submit Job

® 8.1.4 Trackball View

® 8.1.5 Triangle Selection
® Align Parts Facings

® Auto Part Placement

® Back View

® Bottom View

® Bounding Box Display
¢ Copy

® Delete

® De-Select all

® De-Select all Triangles
® Display Support Creation Surface
® Estimate Build Time

® Front View

® Help Topics

® |sometric View

® Mirror

® Right View

® Rotate

® Scale

® Scale inch to mm

® Scale mm to inch

® Selectall

® Selected Part Information
® Selected Parts

® Shaded Display

® Top View

® Translate

® Undo

® Undo Zoom

® Verify

® View All Parts

® View Platform and Parts
® Wire Frame Display

® Zoom

8.1.1 Add Part



To add a part,
click the Add Part
button or select B
File, Add a STL
or CTL File. The
system displays a
file browser dialog
box which you can
use to select one
or more parts.
Select open on the
dialog box to add
part to the print

. SIONES
preview platform. hirside_of_risd 4_CLT

axie_ol_wnad &_CUT

B L B

Click here to return to Print Preview Browser.

8.1.2 Part Selections, Translation,Rotation



Use part selection,
translate, rotate
tool to move parts D MOCEIERERNELTEVIEY 2[X]
in specified X and SRR O Tok e s ; e

Y axis as well as &% 0g15|5) BIE W% 86| BlEI0 #1615 GIGIEIFFRIAIE GiHeieln) siefsvives HREo)
in the X\Y
coordinates. The
parts must be
viewed in top,
bottom left or right
to manipulate
them.

Click here to return to Print Preview Browser.

8.1.3 Submit Job

See Submit Job section to understand how this function is used to submit a job. Once a job is submitted it can be manipulated in print preview.

Click here to return to Print Preview Browser.

8.1.4 Trackball View



Use the trackball
view to change the
platform viewing - 3:DModeler PN PREVTEWL e = 1| X
area. Normal e Edi View Tooks Help

dragging (with the 6] 0f5 515 pinl aw 85[0 eoip|@io@Haaeal alnanell uielyvies el
left mouse button
pressed down)
rotates the viewing
area. When using
the right mouse
button, the build
envelope can be
dragged around
within the viewing
area.

Click here to return to Print Preview Browser.

8.1.5 Triangle Selection



Use the triangle

selection to select

one or more -2 - 3-DModeler BOnE Preview. e = B[
individual Fia Edt Vew Tool Hep

St 8IS 5 RIR| 8% 06 0|50 $|0I9\0|0|SI5 Sik/kik] Gl0e| e Sleldvitels snEe

triangular facets
on parts. After you
select more than
one facet, press
the shift key while
clicking. If you
select more than
one facet on a
single part, that
part will not be
reoriented when
you use the align
facing button.
You may find it
easier to select
specific triangles if
viewing parts as
wireframe. The
2-D views may
also help find the
triangles that you
want to select.

Click here to return to Print Preview Browser.

Align Parts Facings



Instead of manually
rotating parts, you can
select a triangle on the

part and have the ﬁjﬁ?ﬂ_lﬂﬂ
system align the part ] I ] IR S @i U D A b ) MG ) S101P NI o] S
until the selected

triangle faces a desired
direction: up, down, the
X-Z axis or the Y-Z axis.

Select a triangle using
the triangle selection
tool, the align facing
buttons become enable.
Click the align part icons
to rotate the part until
the selected triangle
faces the selected
direction. Triangles can
be selected on several
parts before clicking an
align Parts Facing icons
so that all parts can be
aligned together.

Auto Part Placement



This tool arranges
parts for optimum
build speed. [F = U Modeler FONE ETeVIEW = B A
File Edt viw Took Heb
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place. The parts
will automatically
arrange in the
build envelope.
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Back View



This view point
button is a back
two dimensional =
viewpoint. Se Edt View Took Help
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Links: inch Prodet 5D 3000 Styde: HD |30 Systems, Ine

Bottom View



This view point

button is a bottom

two dimensional T;m}ﬂﬂ?g‘]ﬁm]ﬂ?ﬁz—uﬂu
i i i L Vigw Help
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selected parts on

the build envelope.
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Bounding Box Display



A bounding box for
a set of objects is
a cuboid that
completely
contains the set.

Copy

i - 3-0 Modeler Print Preview - 2
Glle Bt View Tooks Help
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To copy a part, select part
and click on the copy icon.
A dialog box will appear
asking for the number of
copies and the distance
between them. Enter the
number of copies and
distance, click Apply to
generate the copies.

Delete

To delete a part / parts from
the platform, select a part
using the "Select part" or
"Select all" tool and then click
the delete icon to delete the
selected part / parts.
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De-Select all

When using the
De-Select all icon,
all parts on the
platform will

= - 3.0 Modeler Prbnt Prevdew. ] |&x
. Fim e vew Took Help
become statlonary.
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De-Select all Triangles



Use the de-select

all triangles to

de-select the -5 - 3:-DModeler PrinkPreviewl e = 12 X
triangular facets Fia Edt Vew Took Hep

on parts. E(n| ol 5| piR S0 @6 06 $IFIFESISE Fnikie) Ennlecs sielv|vivlps GHinEe
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Display Support Creation Surface



Select the part and
click on the
Display Support
Creation Surface
to identify where
the supports are
placed on the part.
The support
structure will be
high-lighted green.
Use the trackball
to rotate the
platform to view
structure.

¥ - 3-D Modeler Print Preview

Support Structures
are high-lightedin
green.

Estimate Build Time

Click on the estimate build time icon to estimate the time it will take to build the part.

Front View




This view point
button is a front

two dimensional R
viewpoint. o M Toch Hil o _ -
G R Bl As @R SIS0 FRTE SERnRE Lsinniel slelrivitisis g

Help Topics



When selecting

the help topics

icon, 3dpedia log L \Login - 3DPedia - Windows Internet Explorer _J_,jf3|
in page will B X, 3desystems.com 5| 2% ." ol
automatically ik Edt Ve
display asking for Favrites | o 5 Derck_shared @ L ] ~ 3¢ Logn - DWorks 3, - 0OPedia

your User Name - X,8.1032Pre.. MJGoogle K, Logn- 0Pe... W logn-3.. % FirHome = ) iResdMsil (Frint - Pagew Safety = Took = i heip =
and Password. =prre—

After typing in the
log in information, ;
select "Remember -ogin

my login on this Bt yous aceout detas below o bogn o Conbotnca

computer" and

then click on "Log Usermame

In". The ProJet Bt

5000 User Guide ) Bemarmber my g on s computer

will become
available to help in
searching the Not a membser? Snug for an acoount Foeoo password?
information in

question. Adaptnts Themms Busigee

v Favorites Tools Help x &~

Logla

s @ [Aterreat fa = R100% -

Isometric View



This view point

button is an
isometric 3-D o= = Modeler RO Pr e | = ||
viewpoint. It scales B L v sl oy

Elt) of5 35 BlE Al 06l 0IF07eF ASISFPSRIRG ClHinlcielal Slelviviciols) e

and orients the
display to the
standard view
point from one
corner of the build
envelope.

Uits: inch Prodet S0 X000 Styke: HD 30 Systerms, In

Mirror



To create a mirror
image of one or

several parts,
select the parts - 3-0 Mo E
and click the ] I Sl i Al @lei| DISTE M ST Solslaoninial | Sinincien) sletivisoisl LNKo]

mirror icon; the
dialog box will
appear. Choose
an axis around
which to mirror the
part, and a
separation
distance, click

Apply.

Right View



This view point

button is a right

two dimensional D Marc Preview NEC
viewpoint. Fila Edt View Tools Help

Rotate



Select the part to
rotate and click on
the rotate icon.
Use the dialog box
to rotate the
degree amount in
Y,X,Z directions in
the maximum of
180°.

Scale

Wity inch ProJet 50 MO0 Shyle: FD 0 Systerrs,



Parts can be
scaled by
percentages, eith ke x|
isometric meaning
all axes get the
same scale factor
or differently in
each axis. Select
one or several

s 6 20515 LR Q) @6 QIGIBH HED SESLRE MENisien Sigvivivos suKo

parts and click on T
the scale iCOﬂ; the Vasem e ke tm wim o e ek
dialog box v

appears. Enter a
scale value, then
click the apply.
Scale values are
absolute. A value
of 100% always
returns the object
to its original
scale; 200% is
always twice the
size of the original.

Linis: inch Proded 50 3000 Shvie: HO: 30 Sysiems, inc

Scale inch to mm



The parts unit can
be changed from

inch to millimeters fa;: f3|
by multiplying 25.4

to the part £l 6 555 pinl s @Bl 0S0eESSEEE SRR slEnein slelvviees wnER

measurement.

Select the part and
click Scale inch to
mm icon. A dialog
box will ask if you
want to proceed
with the
modifications;
select "Yes" to
proceed with the
parts unit changes
or select "No" to
discontinue.

Linits: inch Prodet S0 3000 Style: HD 30 Systenns, Inc

Scale mm to inch



The parts unit can

be changed from

millimeters to inch

by dividing 25.4 F‘ x|
into the part it I ] i) A @inl DI S R | BT e <l eteiiepiel| D
measurement.
Select the part and
click Scale to inch
icon. A dialog box
will ask if you want
to proceed with
the modifications;
select "Yes" to
proceed with the
parts unit changes
or select "No" to
discontinue. B 80 e moetcatora dore e sebertet ks, wil e ket Drocet?

[T

Lindty irch Frodet 50 3000 Savls: HD' 00 Systema, Inc

Select all



Select a multiple
parts; the parts will
high light once B N
selected. To e e - I — - ~
manipulate parts Eih) BIOME 5 RIE A% 6] D0 #5 TSRS BIEIDIGISE slel Aol S
on the platform,
select the Bottom
View or Top View
icon.

Uinds: ireh Frodet S0 X000 Shyle: HD 10 Sysiema, Inc

Selected Part Information



Click on the
selected part
information icon to E
display the part's
information dialog
with details about
the currently
selected part.
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Selected Parts



View selected
parts enlarges the
selected parts until
they fill the viewing
area.

* - 3-0 Madeler Print Preview:

. File Bt view Took Helo
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Shaded Display



Using a Shaded
Display allows
visualization of the
solid design
structure of a part.
When using the
wireframe display,
toggle back to the
Shaded Display to
view the solid
design.

Top View




This view point
button is a top two
dimensional = 3:10 Modeler Frint Ereview = 1]

viewpoint. It allows ¥ Bt Vi Took Heb )
i) 2J5 305 BlEl sl 96 SlEN0T S Sl ESIPIERIRIG DlElnls] e

you to move the
selected parts on
the build envelope.

Translate



Use the translate
part dialog box to
move parts by
entering inch
values. The dialog
box allows relative
movement (parts
are moved from
their current
location in
specified X and Y
axis) as well as
absolute (parts are
specified in the
specified X,Y
coordinates).

Undo
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Click the undo
icon to bring part
back to its
previous state
after changes
have been made.
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Undo Zoom



Click on the undo
zoom button

continously, the PAOGEIRT N FTEVIEN = [2]X]
build envelope will Hlo Et Wien Took He0

d p B8] 5] i Iiglﬂﬂl B|5/6 o5 5169 @I@| @885, | Bss|o|n]s
reauce

incrementally until
they are at the
normal viewing
area.

Verify

Verification detects and fixes problems in the STL. Also individual STL part can be verified by selecting it and then clicking the Verify icon.

View All Parts



View all parts
display the parts,
and enlarges them
as much as
possible omitting
empty portions of

the build envelope.

3-D Modeler Print Preview

View Platform and Parts




This predefined
view zooms the

view to include the B L L L 3 T — =
entire build R T N . -
envelope and all i 16 S5 Rl AN QI8 LIFTRTE SSOSEISRG clulslels Selvivicisi LKl

the parts on the
platform.

Unis: irch Prodet SO 3000 Syl HD |30 Systems, |

Wire Frame Display



Using a wire frame
allows
visualization of the
underlying design
structure of a part.

3-D Modeler, Print Preview,

Zoom




Zoom in on the
parts incrementally
to enlarge until

B L —————— |~ d )
they fill the viewing Flle [k View Took Heo
area. Click and i) 0101 %) PRI N 16| DIE0 5 HIGISIFTGIRIRE] 0lEins

hold the mouse
button until and
drag across the
area that you wish
to zoom in on for
part detail.

8.2 Save a Build Job

Prepare and save build job(s) on your PC. Later, submit the job, skipping preparation steps. A saved job is specific to a single PC and can only
be built or deleted from that PC.

1. Click a printer's icon in 3-D printer's window to open the Info window.
B Client Manager - 3-D Modelers

File Yiew Help
] Open 3-D Madeler  Chrl+0

Add 3-D Modeler Chrl+a E B = o]

3-D Modeler Ctrl+D .@ % % E‘@ W]

— ic projet invision invsion2 invision3 projet2 invisiond 3
Exit R
= ~
Add a new 3-D Modeler

3D Systems, Inc. /J




i Plastic ProJet - Info

| End Time

I~ Job Name: | defaul

SelectFiles... | Fercvefile: | Options...

Select CAD Files

L) Look in: IE} Samples L] - £k B
For Help,

File name: ISampIe.stI Open I IV File Preview
Files of type:  |STL Files [*st] | Cancel

2. Select Job name to be saved. A
3. Choose Job > Default Options.

X

Default Job Options

v VeiySTLfie Sk Comp )

[ SaveVerfied STL file
S i v! 0.00

¥ Enable Part Placement

[T Savedob ¥ Ijv 0.00

[ Quick Build Orientation = I 'i 000

[~ Shareable

¥ Ulra High Definition [LHD]

— Unitz—
% |nch

BuildStyle: I'-.rert:c:-zi Calumis _ﬂ © mm

] I Rezet | Cancel

4. In the Default Job Options, select Save Job, then click OK.

Save Job option enabled reaches Pending status, another job (with the suffix *_s") is added to the queue. For more

F After submitting jobs to the printer's queue, it cannot be saved unless Save Job was selected. When a build job with the
information see Saving, Repeat, and Confirming Build Jobs in your ProJet Client online Help for more information.

—

8.3 Submit a Build Job

ﬁ Make certain the printer is Off-Line during the job submittal process. Place the printer on-line after the job is submitted.

C—

1. Click on printer's icon in the printer's window. The printer's Info window opens.



B Client Manager - 3-D Modelers
File Wew Help

%% @]
U

add modeler 2Imu

uz-ws-3048

For Help, press F1 30 Systems, Inc, 7

2. In printer's Info window, click Submit to open Submit dialog box.

& ProJet - Info

File Modeler Job VWiew Help

Subrmit a
EEI - || olelele| O

Exit | I Job Status I Build Time I Start Time: I End Time
johnsond@us-ws-0880-0011 Printing 11:16 Tue, Mar 18, 2008 02:51 PM Wed, Mar 19, 2008 03:43
pursleypl@us-ws-0717-0007 Previewing 0300 e e
< | 3
Submit & job ["ProJet"; Printing Tue, Mar 18, 2008 04:33:46 PM [ProJet HD 3000 (3D A

3. Click Select Files on the Submit dialog box to add one or more parts to the build job.

on several STL files. Add parts in Preview window. After you have added at least one STL file, use Preview window
to view build jobs in three dimensions, and to add more STL files if desired. Sample STL files are in the \3-D
Modeling Client\Samplesfolder.

F More than one STL file can be selected at a time. In Select CAD Files dialog box, hold down the Ctrl key and click
—_—

Click the Submit Icon
Click the Select Files...

Double Click on Sample.stl file

i Plastic ProJet - Info

| End Time

<

For Help,

File name: |Sample.st| Open I IV File Preview
Files of type: |STL Files [*.st) ;l Cancel |

a

4. Browse files in Select CAD files window. When files are selected, file names appear in build job parts list of Submit dialog box.
5. Click Options...button on Submit dialog box. The Default Job Options dialog box appears.



Default Job Options E]

Shrink. Comp [%)

SaveWerfied STL file
¥ Enable Part Placement

|- 0.00

[ Saveldob ¥ 3 0.00
[ Quick Build Orientation - |- .00
™ Shareable s

; doi Itz
¥ Ulra High Definition [UHD) & Inch
BuildStyle: ~ [Vertical Calurmns ~ |  mm

] | Feset ‘ Cancel

6. Change or reset values, such as Build Style, Shrink Comp (%), and Units. (See "Default Job Options Dialog Box" in the 3-D Modeling
Client online Help for job options definitions.)

Parts shrink in X and Y. The degree of shrinkage depends on part geometry. To improve part accuracy, apply the X,
Y, and Z Shrink Comp (%) values below initially, then measure your parts and refine these values.
—_

|| DIM. || SHRINK COMP % (INIT.) ||

x 1.12
y 119

z 0.00

7. Click Preview on Submit dialog box.

Submit X
[~ Job Mame:; ]
Select Files... I Hemove Files ] Options ... I
] Job Scale [%]:
M ame Estents
v] 25
C:5Program Filesh3D Swetem... 3112 #3112 20522 in |
Copies:
= 1
=t
< | 2 [ Preparation Only
Presie. .. I | Subrnit | Cancel I
UHD maode is l:'l'.u'réntl_;,l selected. Click i':Ii:ni:iEns' ta Ehangie.-

8. Manipulate parts interactively in the Preview window's virtual printer 3-D build workspace.
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9. If required, resize all parts in build job by the same scale factor, enter a Job Scale % in the Submit dialog box before clicking Submit. To

resize some of the parts of your job, use Edit > Scale in Preview. (See the topic "Previewing Print Jobs > Scaling Parts" in your ProJet
Client online Help for instructions.)

Comp % values in the Default Job Options dialog box. Applying scale percentages changes "nominal" part
dimensions in the STL file(s). Applying Shrink Comp percentages does not change nominal part dimensions in the

STL file(s). Rather, Shrink Comp adjusts for expected shrinkage during the build so the actual final part dimensions
more closely match the nominal dimensions.

N Applying Job Scale % (or scale percentage(s) using Edit > Scale in Preview)) is different than applying Shrink
—_—

x|
I Isometiic Scale | 100 %

% Y z
| 112 | 1.19 | oog %

Motice: Input scale value relative ta the orgnal model.
Apoty | Close |

1. See Previewing Build Jobs.

1. Click Submit on Submit dialog box if you did not preview the job, or click Submit toolbar button in the Preview window if you did preview
the job.



Submit

[ Jab Mame; |
Select Files... | ] Optionz ... |
| Job Scale [%]:
M arne Estents
- 25
C:AProgram Filesh3D System... 3112 % 3112 « 0.522 in |

Copies:
K
et

2 [ Preparation Orly

Presview... I Submit | Cancel |

UHD mode is currently zelected. Click I:Ipi:icuns ta changie.

1. The build job submitted will be built when printer is ready unless:
® |tis OFFLINE, in which case press the ONLINE button on the printer's panel.

Scroll up

Light- on/off LCD Display Pause

job Online/Offline

Abort job Confirm YES Confirm NO Menu Scroll down
® |t does not have a clean build platform installed; install clean one and press ONLINE.

® The Preparation Only option in the Submit dialog box was checked. This causes the modeler to wait until the build job was
confirmed before building --- enabling you to change the job in the Preview window again before confirming.

See "Checking printer Status" and "Confirming Build Jobs" in the online Help for more information.
S
—

2. When the Operator panel LCD shows PLATFORM EMPTY? Y/N, verify platform is clean and free of debris. If required, press NO and
remove build platform from the printer to replace. See 7.2 Install & Remove Material Bottles and Build Platform

3. Close chamber door and press ONLINE. When the Operator panel LCD shows PLATFORM EMPTY? Y/N, press YES. If the display
shows please Empty Waste Drawer, waste on the next build will exceed waste capacity, open the waste drawer and dispose of waste
material. See 4.7 Waste Removal

4. Close waste drawer. The job starts automatically.

If the display shows *WAITING FOR JOB, no jobs are in the printer's queue. Go back to Step 2 and submit a build job to
>, | the queue. Once in the queue, the job starts automatically.*
—

5. Refer to Manage build jobs for additional information.

8.3.1 Remove Build Platform

When operator panel display shows DONE: <job_name> remove build.



1. Lift chamber door.

2. Lift up build platform and pull out, then install a clean platform or close chamber door. See 7.2 Install & Remove Material Bottles and

Build Platform

8.4 Manage Build Jobs

The client software will not send build jobs to the printer until job confirmed by selecting Preparation Only checkbox on Submit dialog box or

resubmit a saved build job.

Submit

X]

I~ Job Marme: ]-.':*.'-';;:-a

Select Files... ] Hemove Files 1

Options ... ]

M ame ] Entents

Job Scale [%]:

|

i

|

- ] 100
Copies:
ﬁ 1

Cancel I

'UHD mode is cumently selected. Click Options to change.

1. Click printer's icon in client software to open printer's Info window.

B Client Manager - 3-D Modelers

BEE

Filz Wiew Help

L]
=

add modeler zimu

uz-ws-3048

For Help, press F1

30 Systems, Inc,

2. Select build job with Job Status of Needs Confirm or Saved.

3. Click Confirm button or choose Job > Confirm located on the tool bar of the printer's window.




& ProJet - Info B@@

Fle Modeler Job View Help

wj¢] sial5] olejele] @

Jab Name | Job Status | Buid Time | Star Time | End Time
johnsond@us-ws-0880-0011 Printing 10:59 Tue, Mar 18, 2008 0251 PM ‘Wed, Mar 19, 2008 0349
purslepp@us-ws-0717-0007 Previewing 000 e

¢ | >
|For Help, press F1 "PraJet"; Printing \Tue, Mar 18, 2008 04:50:42 PM ProJet HD 3000 \SD /

4. Click Yes. Job is sent to printer as soon as it's available.

L] ": Do wou want bo submit oliverm@us-ws-3048-0006 Lo projet 7
L

A Needs Confirm build job status immediately changes to Pending when confirmed.

¢ Confirming saved jobs generates a Pending build job whose name lacks the "_s" suffix. However, saved jobs remain in the
queue.
—_—

8.4.1 Delete Build Jobs
8.4.2 Pause Build Job
8.4.3 Abort Build Job

8.4.4 Repeat Build Job

8.4.1 Delete Build Jobs

Follow the instructions below to delete one or more jobs from the queue after you submitted.

1. Click on modeler's icon in modelers window to open Info window.



B Client Manager - 3-D Modelers
File Wew Help

%|% /% @f

= =3
add modeler imu

For Help, press F1

uz-ws-3048

30 Systems, Inc, 7

2. Select build job(s) to delete. (Ctrl-click to select several jobs.)

& ProJet - Info

L4
For Help, press F1

File Modeler Job  View Help

&|2| 9|%|%| ole(ee

Job Name | Job Status | Build Time | Start Time | End Time
iohnsond@us-ws-0880-0011 Printing 10:59 Tue, Mar 18, 2008 0251 PM Wed, Mar 19, 2008 03:49
pursleypiaiys-ws-0717-0007 Previewing 0300 e e

| >

"Prodet": Printing  [Tue, Mar 18, 2008 04:50:42 PM [ProJet HD 3000 (3D

3. Click Delete or Delete All button or choose Job > Delete or > Delete All.

Delete
Delete All

“& ProJet - Info

LER

<
For Help, press F1

4. To delete all jobs, click the Delete All button or choose Job > Delete All. If you use Delete All, and there are saved jobs, the ProJet

File Modeler \lob\ ¥iew Help

8/¢| 4%/ ole/ole) @)

Job Name | Job Status | Build Time | Stat Time | End Time

iohnsondi@us-ws-0880-0011 Printing 10:59 Tue, Mar 18, 2008 0251 PM Wed, Mar 19, 2008 03:43
0717-0007 Previewing 0200 e e

| »
"Pradet”: Printing  Tug, Mar 18, 2008 04:50:42 PM ProJet HD 3000 3D

Client will ask you if you want to delete saved jobs as well as other ones.



projet
'T Job "olivermi@us-ws-30438-00056" needs canfirmation,

£ Delete This Job 7

If you delete a job that is currently building; this aborts the build operation. However, the job status will continue to
show as "Building" at the PC until deletion is confirmed at the modeler.
—_—

8.4.2 Pause Build Job

Press PAUSE. When display shows PAUSE JOB? Y/N, press YES to pause building or NO to keep building.

$’ The modeler keeps building after pressing PAUSE while it displays PAUSE JOB? Y/N.!
—

If YES was pressed in response to PAUSE JOB? Y/N, the modeler completes current layer or its current task. Then moves the platform forward
while chamber door and waste drawer remain locked. Press PAUSE again to resume paused job. If you don't press PAUSE again, the paused

job resumes automatically after 5 minutes.
® |f you press NO in response to PAUSE JOB? Y/N, the job does not pause and the confirmation prompt disappears.

8.4.3 Abort Build Job

Press ABORT.
When display shows ABORT JOB? - Y/N, press YES to abort the build job or NO to continue. The modeler keeps building after you press
ABORT while it displays ABORT JOB? - Y/N.



If you press YES in response to ABORT JOB?- Y/N, the modeler does the following:

® Stops building immediately.
® Displays waiting for DSP (Digital Signal Procesor) done.

N

w——J Abort does not finish the current layer or current task.

Displays Finishing Build while it cures any uncured material on the platform.
Displays Raising Printhead as it raises the printhead.

Moves the platform forward and unlocks the chamber door.

Displays:abort: <job_name> remove print

Scroll up

. P
Light- on/off LCD Display ose Online/Offline

Abort job Confirm YES Confirm NO Menu Scroll down

You can now remove the platform. See "7.2 Install & Remove Material Bottles and Build Platform".
If you press NO in response to ABORT JOB? - Y/N, the job does not abort and the confirmation prompt disappears.

8.4.4 Repeat Build Job

¢ Do not select Repeat from the Operators Panel after a test print.
A
—_—

1. Press MENU, scroll to highlight REPEAT BUILD. # Press YES; the system displays PLATFORM CLEAR? Y/N.
2. When platform is clear, press YES. The modeler repeats the previous build job.
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8.5 Printer Status

To view the status of the printer, observe the Liquid Crystal Display (LCD) screen located on the printer for elapsed build time, Build time
remaining, material information, job status, name, time remaining on build, error messages, and System Statistics.

| Display “LCD" |

8.6 Empty Waste Drawer

Personal protection equipment is required before opening waste drawer. Follow all material handling and disposal
guidelines. Always follow MSDS guidelines and local regulations regarding handling and disposal of regulated materials.
Keep disposal records if local law requires.

Caution: Wear protective gloves before removing any waste material. Be careful not to spill, drop, or expose others to
these materials. Dispose the material according to your local regulatory guidelines.

When removing the draped portion of the bag, be careful not to spill the material that may be on the top portion of the bag.

P>

1. Open waste drawer.

2. Remove waste bag from waste bag holder by rolling the draped portion of bag from the sides of the holder. Take care that the rear edge
of the bag is taught. Push the top frame and remove bag.

3. Reverse procedure to install new bag.

4. Close waste draw and press "ONLINE* to resume.



‘Online/
Offline

8.7 Shutdown Printer

Switching off or disconnecting the printer's power without going through a shutdown process can damage the printer.

Always perform shutdown procedures before switching off printer's power unless power must be disconnected
immediately for safety reasons.

The printer takes approximately 45 minutes from a completely cold state. Once the MDM bottles are placed in the cubbies,

it will take approximately 120 minutes for the bottles to become heated. Before shutdown and switching off, verify no need
to build parts again soon.

' [

Time
Standby 15 Min.
Conserve 25 Min.

Initial Pwr Up =~ 165 Min.

It is recommended to leave your printer in either standby or conserve mode instead of shutting down if the printer is to be
used within 7 to 10 days of last build.
—

After printer is idle more than 2 hours up to 72 hours, it enters Standby or Conserve mode, respectively. In these energy-saving states, the
printer's heaters are partially cooled and many other components are disabled. The heaters are cooler in Conserve mode more than Standby

mode. It takes much less time for the printer to warm up from Standby or Conserve mode than it does from full shutdown/power off. Warming up
from Conserve mode takes more time than from Standby.

To increase or decrease wait time before the printer enters Standby mode or Conserve mode, contact 3D Systems Technical Support.

1. Verify printer is not building.
2. Abort current build job.

1. Press MENU, scroll to highlight SHUTDOWN.



|E~::r_nll Up

Scroll Down |

1. Press YES twice.
2. When the display shows OK TO POWER OFF XXX, press the power switch on the rear panel.

ﬁ\ To halt shutdown, press "ONLINE" before you press the power switch.
P
A

[

8.8 Remove Part from Build Platform

Remove build platform from printer. Refer to section 8.4 Manage Build Jobs.

® Place warm platform of parts in a freezer for a few minutes. As the parts and platform cool, they contract at different rates and separate.

® Alternatively, the parts can be mechanically separated from the build plaform by force using a tool with a stiff thin blade such as a putty
knife. Make certain you do not mark the platform. For more information on how to clean parts, refer to the VisiJet® Material Handling
Guide.

8.9 Shrink Compensation for VisiJet® MX Part Material

Material shrinkage occurs in thermoplastics as they transition from liquid state to solid (change in density). In the case of photopolymers used in
the Multi-Jet building process, this shrinkage can occur during the curing stage of printing.

The ProJet Accelerator Client Software has features built in to allow a user to compensate for the natural shrinkage of the material and also fine
tune the accuracy of a part.

The instructions below will explain the process for entering shrink compensation and fine tuning part accuracy using scaling factors.

SHRINK COMPENSATION VALUES FOR VISIJET® MX PART MATERIAL

Xvalue Y value Zvalue

0.60 0.60 0.00

1. Enter Standard Shrink Compensation Values for the material.
a. Open ProJet Accelerator Client software and select the desired printer.
b. Select the part to build.
c. Select the "Options" button.
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d. Within the Options panel, enter shrink compensations values for X or Y. Z compensation is rarely necessary (see table above for the values).*
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2. Identify the exact X and Y dimensions of the part using a CAD program.
a. Most CAD programs and simple stl file viewers will provide a way to view a part with its dimensions.
b. Make note of the actual X and Y dimensions as XCAD and YCAD.

3. Build and clean the part and take measurements of the finished part.

a. It is recommended to measure along the critical dimensions of the geometry, take measurements in multiple areas and take an average of
the values.

b. Measurements can be made using calipers or more advanced metrology methods.

c. Make note of the X and Y dimensions of the printed part and mark them as XPART and YPART

NOTE: If the measurement of the finished part is different from the measurements of the CAD model, fine tune the accuracy using
scaling factors.

4. Determine "Scaling Factor" to use for the next build
a. Use the following formula calculate the scaling percentage to be used on the “fine tuning” build:

X Scaling Factor = (XCAD - XPART)/ XCAD * 100 (answer will be as a percentage)

Y Scaling Factor = (YCAD - YPART)/ YCAD * 100 (answer will be as a percentage)

EXAMPLE:

X measurement of CAD model = 3.000"

Y measurement of CAD model = 5.000"

X measurement of printed part = 2.998"

Y measurement of printed part = 4.989"

X Scaling Factor = (3.000 — 2.998)/3.000 *100 = 0.067%

Y Scaling Factor = (5.000 — 4.989)/5.000 * 100 = 0.22%

5. Enter "Scaling Factor" for adjustment build



a. Open ProJet Accelerator Client software and select the desired printer.

b. Select the part to print

c. Open Print Preview to view the part. Select the part (color should be yellow)

d. Select the "Scale" Icon and enter the dialog box to enter the above scaling factors.

e. Uncheck the "Isometric Scale" button. This allows user to make individual x and y adjustments.
f. In the example above the x scaling factor should be 100% + 0.067% = 100.067%

d. The y scaling factor should be 100% + 0.22% = 100.22%

e. Enter these two numbers in the corresponding scaling boxes for x and y.

Scale Selected Parts X
[ lzometiic Scale 2
bt i pd
100.067 100.22 | oo E

Maotice: Input scale value relatvve to the onanal model,

Elus:el

o

Build Part with Scaling Factors and measure
a. Additional iterations of adjusting scaling factors and taking measurements may be necessary with certain geometries.

09.0 Maintenance

The following general maintenance procedures provided must be accomplished to help maintain high part yield and low printer down time.

9.1 Cleaning Printer Surfaces
9.2 Cleaning the Waste Drawer
9.3 Preventive Maintenance
9.4 Return Printer for Repair
9.5 UV LED Cleaning Procedure
® 9.5.1 UVLED Board Removal Procedure
9.6 Cleaning MDM Areas
® 9.7 Changing the Charcoal Fan Filter
® 9.8 Printhead Maintenance

9.1 Cleaning Printer Surfaces

: Do not remove any outer panels when cleaning the printer. Panels must only be removed by qualified 3D
Systems Technical Support Representatives.

—

® Remove dust from outer surfaces of the printer by wiping with a clean dry, lint-free cloth.

® Dust and clean the outside surfaces only. DO NOT
dust inside the build area.

®* Remove dirt and grease from on the outer surfaces
by spraying an all purpose cleaner on a clean cloth
and gently wiping.

® se only non-abrasive, alcohol-free cleaners to clean
surfaces. DO NOT use all purpose cleaners using
petroleum-based polishing agents such as liquid
wax. Spray the cleaner on the cloth, not on the
surface.

® Do NOT use any cleaning solvents on the build
chamber window as this can damage its protective
UV coating.



Use only non-abrasive, alcohol-free cleaners to clean surfaces. Do not use all-purpose cleaners containing
petroleum-based polishing agents such asligquid we n cloth, not on surface. Do not use cleaning

solvents on build chamber window due to e UV coatng
r

® Switch the printer OFF. Remove dirt, grease, and ‘
build material residue from operator panel buttons ‘
and display window using a mild soap and water on
a clean, lint-free cloth gently wiping the buttons and
windows.

. — ‘ .
¢ Remove build platform before cleaning the operz ] his-wity PrR ting any
actions when buttons are pressed. -
— ——— - —

* Remove dirt, grease, and build material residue
from operator panel buttons, display window by
spraying an ammonia-based cleaner (e.g.,
Windex®) on a clean, lint-free cloth then gently
wiping the buttons and display window.

9.2 Cleaning the Waste Drawer

Review VisiJet material handling and disposal safet
the waste drawer. [

—

Clean printer's waste drawer as follows:

1. Verify modeler is OFFLINE.
2. Put on protective gloves. Refer to Personal Protection Equipment.

ey

Empty waste drawer.Refer to 8.6 Empty Waste Drawer.

Dispose waste bag if required. Refer to Disposal.

. Re-install bag. Refer to 8.6 Empty Waste Drawer.

. Gently scrape any material stuck onto interior surface of waste drawer bin. Use a flexible plastic scraper to avoid damaging the paint.

oo rw®



7. Vacuum inside waste drawer to remove scrapings.
8. Wipe inside surfaces of waste drawer using a clean cloth and all-purpose spray cleaner.

9.3 Preventive Maintenance

Preventive maintenance must be performed by qualified 3D Systems Technical Support Representatives or by an authorized servicing reseller
after either one year of total build time, or consuming 208 Ib (94 kg) of build and support materials combined.

The printer automatically tracks total build time and combined weight of material consumed to date. When either the time or weight limit

mentioned above is reached, its LCD panel will prompt you to contact 3D Systems Technical Support to schedule a PM visit. When prompted,
schedule PM as soon as possible in keeping with the terms of your 3-D printer warranty.

9.4 Return Printer for Repair

Guidelines for repacking the printer

When shipping the printer for service or repair, use the original shipping carton and packing material. Shipping damage as a result of inadequate
packing is your responsibility. If you have already disposed of the packing material, contact 3D Systems Customer Support for information on

repacking the printer.

9.5 UV LED Cleaning Procedure
Each LED has "glass window" for air sealing and optical performance. The window material is hard glass (Borosilicate) and the size is diameter
4.35mm, thickness 0.55mm. Even though the glass is mechanically hard enough to clean the surface, be cautious! It is important to clean the

LED windows periodically as optical power is very sensitive to the transparency of the window.

CAUTION: To prevent personal injury or damage to the printer, shut down the printer and disconnect the power before
performing the UVLED Cleaning Procedures. ! Wear protective eye wear and gloves!

When there Is resin or dust on the LED window:



[N

. If optical power of LED has dropped due to dust or resin on its glass
surface, remove its LED board (three boards per one system) from
its assembly.

2. If dust on the surface you can use a soft bristle paint brush and

lightly brush off any dust that may be present.

3. NOTE: The removal of the board will need to be done if any

cooked on material is present.

4. If dust is not removable, the use of a few drops of alcohol on a Q-tip

to clean the particles from the surface can be done. The size of

window is relatively small (dia. 4.35mm) so the Q-tip should be
smaller than the size of the LED glass surface and focus on only the
window.

'CAUTION: Please be cautious not to
smear alcohol to whole area of LED
package . It would be the safest to
remove power to the LED’s to avoid a
short. You should be able to see the
inside LED chips clearly through the
LED window if cleaned successfully.

When there is liquid/uncured resin or partially cured resin on the LED
window:

1. If liquid/uncured resin is on the surface, use alcohol and Q-tips as in
"Step 4- When there Is resin or dust on the LED window." until hard
particles on the window are completely removed.

2. If partially cured resin or sticky substance is stuck on the LED
window, a piece of wood (or hard plastic scraping tool) or the other
side of Q-tip can be used to remove by scraping it away from the
surface.

3. After removing the resin, repeat Step 2 again until particles on the
window are completely removed.

When resin is cured completely/stuck on the LED window

Electro-static protection for grounding is required when
‘ removing the circuit board to avoid damage to the board. If
you do not feel that this is in your area of expertise, please
m contact 3D Systems Customer Service for customer
support: US/Canada (800) 793-3669 Central Region, Europe
+49-6151-357357



1. During normal operation of the modeler high temperature are used.
After a mis-build or after long periods of operation, material can be
"cooked" to the surface of the LED.

2. To clean, remove the board (see UVLED Board Removal Procedure)
in question and use a razor blade or sharp metal knife to scrape
away (only window glass area) the stuck resin/unnecessary
substances. The glass window is hard enough to use the blade or
metal knife, but be cautious. After removing the substances on the
window, clean the window as described in Step 4- "When there Is
resin or dust on the LED window."

® 9.5.1 UVLED Board Removal Procedure

9.5.1 UVLED Board Removal Procedure

CAUTION: To prevent personal injury or damage to the modeler, shut down the modeler and disconnect the power before
performing the UVLED Board Removal Procedures. ! Wear protective eye wear and gloves!

Electro-static protection for grounding is required when removing the circuit board to avoid damage to the board. If
you do not feel that this is in your area of expertise, please contact 3D Systems Customer Service for customer
i ‘ support: US/Canada (800) 793-3669; Central Region, Europe +49-6151-357357

1. Disconnect the three wire connectors located on the top side of the
three UVLED boards.

NOTE: Before touching the boards UVLEDSs, ensure your fingers are
clean of any oily residue. If oily residue contacts the UVLEDs, it may
cause damage to them.



2. Using a 2mm Allen wrench, remove the four (4) screws and the electrical
cover from the board that is to be removed (middle board is shown for
depiction purpose).

3. Remove board from UVLED holder assembly.

4. If cleaning is required for the UVLEDS, refer to the UVLED Cleaning
Procedures.

5. If installing a new board, reverse this procedure.

Electrical
Cover

NOTE: When installing board, ensure the electrical cover is re-install at
the location shown in the picture. If the cover is not installed, it will
short out the board. Also, ensure screws are tighten securely and not
loosely where they are hanging down from the board.

Electrical
Cover

9.6 Cleaning MDM Areas

® Verify that the printer is OFFLINE.

® Wear protective gloves.

® Open the side panels and gently scrape off any material adhered to the metal surfaces. Use a flexible plastic scraper to avoid damaging
the paint.
DO not clean the backside of the MDM.

® Vacuum inside around the MDM clamps and the back area around manifold to remove the scrapings.

® Wipe the inside surfaces using a clean cloth and all-purpose spray cleaner.

® |f material residue is on the back side where the MDM connects to the manifold, BE CAREFUL not to damage wires and fittings when
cleaning.

9.7 Changing the Charcoal Fan Filter

The fan filter will need to replace every 30 days to ensure the printer will perform at it's optimal level.
To replace filter:

® Using a flat screwdriver, turn the two top thumb screws on the fan back panel counterclockwise.



® Pull fan out and discard.
® |nstall new fan filter and secure fan panel turnin

9.8 Printhead Maintenance

The printhead will need to be cleaned after every build. PH Maintenance).

To access the PH Maintenance Mode:

® Close chamber door.
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the panel. Lift panel out at

® Visually inspect the UV LEDS to ensure they do see the UVLED CLEANING
® Clean areas where materials debris may have accumplated
® Inspect the planerizer for damage. Also, wipe the
planerizer roller using a lint free cloth and acetone.
® Clean the printhead's array plate using a lint free
cloth and acetone. Ensure that it is sufficiently

cleaned and that there are no drips left on plate.

10.0 Error Messages

There are three primary types of error messages which could
appear on the operator panel display of your printer. The
primary types of error messages found will be Build, Material
, and 10.3 Status and Message Lines.

Scroll up

. P
Light- on/off LCD Display ose Online/Offline

Abort job Confirm YES Confirm NO Menu Scroll down

® 10.1 Build Messages
® 10.2 Material Messages
® 10.3 Status and Message Lines

10.1 Build Messages

Use these messages to help you manage print jobs before,
during, and after printing. The causes of and actions to take
in response to various messages are described in the
following table:

MESSAGE CAUSE ACTION
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10.2
Material Messages
Use the following messages to help manage build jobs

before, during, and after building. The causes and actions to
take to various messages are described below:

MESSAGE CAUSE ACTION

#X PART The current number of modeling material bottle in the right material delivery system. None

#X SUPPORT  The current number of support material bottle in the left material delivery systems. None

ADD PART The maximum number of model material bottles in the right material delivery system are four (4) = Add model material
bottles. bottles.

ADD The maximum number of support material bottles in the left material delivery system are four (4). = Add support material

SUPPORT bottles.

10.3 Status and Message Lines

Messages appear either on the Status line or the Message line. Read both lines together to determine the exact state of the modeler. The Status
line generally indicates current state of the modeler. The Message line shows the action to take to complete a function and move to the next step.

MESSAGE CAUSE ACTION

ABORT ABORT button pressed. Refer to abort build job. Press YES to abort or NO to cancel the command.
ABORT You confirmed an abort command. The modeler is aborting the | None.

ACKNOWLEDGED | current job. Refer to abort build job.

BUILD PAUSED PAUSE button pressed during the build. The build platform Press PAUSE to continue. Refer to pause build job.

moves forward and the chamber door and waste drawer remain
locked. When you press the PAUSE button during a build, the
modeler completes its current task before stopping.

CLEANING The modeler is cleaning the build jets. None. (This occurs automatically before every build.)
PRINTHEAD

CLOSE DOORS The chamber door is open. Close the chamber door.

CONFIRM The modeler is prompting you to verify the platform is clean and | Verify the platform is clean and clear, then press YES
PLATFORM clear of obstructions. Refer to installation of build platform. to continue or press ABORT to cancel.

CLEAR OR

CANCEL



PRESS PAUSE
TO CONTINUE

CYCLE POWER
TO CONTINUE

DONE REMOVE
BUILD

HOMING
PRINTHEAD

HOMING X -Y

INSTALL
PLATFORM

NOT BUILDING

OK TO POWER
OFF

ONLINE/MENU?

PAUSE
ACKNOWLEDGE

PLEASE WAIT

PRE-JOB

CHECKS

BUILDING

RAISING

PLATFORM

REMOVE BUILD

SHUTDOWN IN
PROGRESS

SHUTDOWN
COMPLETE

The modeler is paused.
A severe error occurred. The modeler cannot recover from it
and must be switched off.

The modeler completed building the current job.

The modeler is initializing the Z-axis prior to building.

The modeler is initializing the X-axis and Y-axis prior to building.

The modeler cannot detect a platform.

The modeler is ready to build.
The modeler completed its internal shutdown procedure and is

ready to be shutdown.
Refer to modeler shutdown.

The modeler is ready to build.

The PAUSE button was pressed. The modeler is acknowledging
and complying with the command.

The modeler is cooling to shutdown temperature.

Briefly displayed during modeler build preparation.

The modeler is currently building.

The modeler is raising the printhead so you can remove the

platform.

The modeler completed a build job and unlocked the chamber
door so you can remove the platform.

You selected the SHUTDOWN menu option, then pressed YES
twice. The modeler is cooling down so power can be switched
off. Refer to modeler shutdown.

Modeler cooldown is complete; modeler is ready for power off.

Press PAUSE to continue or ABORT to cancel.

Cycle power to the modeler. If the error message
occurs again, contact your Technical Support Hotline.

Remove the platform. Refer to removal of build
platform.

None.

None.

Install a clean platform. Refer to installation of build
platform.

Press ONLINE to build or MENU to list menu options.

Toggle power switch on modeler rear panel to the
OFF position.

NOTE

Before you switch power off, verify you will
not need to build parts again soon. It can
take several hours for the modeler to warm
up after you switch power back on.

Press ONLINE to build, MENU to list menu selections.

None.

NOTE

If you press PAUSE during a print job, the
current layer or process is completed
before the pause takes effect.

Wait for the modeler to complete its shutdown
procedures. Refer to modeler shutdown.

None.

Allow the build job to continue or press PAUSE or
ABORT to stop building.

None.

Remove the platform and replace it with a clean
platform. Refer to removal of build platform.

None. DO NOT switch off the modeler while
shutdown is in progress.

Wait for OK TO POWER OFF message, then switch
power off at the modeler's rear panel.

NOTE:

Before you switch power off, verify you will
not need to build parts again soon. It can
take several hours for the modeler to warm
up after you switch power back on. Refer
to modeler shutdown.



STANDBY The modeler is in energy-saver mode. All internal subsystems None.
are partially cooled and the modeler is inactive. The modeler will warm to operating temperature when
you press any button or submit a build job.

WAITING FOR The modeler is online, but there is no build job in it's queue. The = Submit a build job to the modeler. Refer to submit a
JOB modeler is ready to build as soon as it receives a job. build job.

WARMING STAGE | The material heaters and printhead jet heaters gradually warm None.

[4,3,2,1] up to either standby or build temperature. The numbers on the LCD panel count down as the
modeler warms up.
At Warming Stage 1, all heaters and material are at
build temperature.

11.0 Troubleshooting

If problems occur with the printer, error messages appear on the LCD of the Operator's panel. Refer to appropriate troubleshooting table for
assistance. There may be times when an unrecoverable error message will appear and will require a call to Technical Support Hotline. Prior to
contacting Technical Support Hotline ensure you have serial number of the printer, a brief description of the problem including exact error
message displayed on the LCD panel, and when the problem occurred (while submitting a job, during the beginning or end of the build, after
power off recovery, etc.)

Scroll up

. . Pause
Light- on/off LCD Display job Online/Offline

Abort job Confirm YES Confirm NO Menu Scroll down

11.1 Communication Errors

11.2 Head Maintenance Station Errors

11.3 Material Feed and Waste System Errors
11.4 Material Quality Guarantee Errors

11.5 Material Waste Errors

11.6 Motion System Errors

11.7 UV Subsystem Errors

11.8 Vacuum Regulator Errors

11.9 Power Outage

11.1 Communication Errors

MESSAGE CAUSE ACTION

RT_ERROR: No machine  No network Ensure you have a valid network connection. Cycle power to the modeler. If error

Identification (ID) connection. message occurs again, contact your Technical Support Hotline.

evm6x_hpi_open() A communication Cycle power to the modeler. If this does not restore communication, contact your
error occurred. Technical Support Hotline.

evme6x_init_emif() A communication Cycle power to the modeler. If this does not restore communication, contact your
error occurred. Technical Support Hotline

11.2 Head Maintenance Station Errors



MESSAGE CAUSE

HMS ERROR ' An error occurred during printhead maintenance (cleaning

Recovery the printhead before beginning a build).

ACTION

Cycle power to the modeler. If error message occurs again,

contact your Technical Support Hotline.

11.3 Material Feed and Waste System Errors

A just loaded cartridge did not engage correctly during the material feed cycle or the printhead sensors did not detect the required material level.

MESSAGE CAUSE ACTION

RT_ERROR: material A just loaded bottle did not engage correctly during the material feed cycle = Cycle power to the modeler.
feed 1 (or 2) can't fill or the printhead sensors did not detect the required material level. If error message occurs again,
head contact your Technical Support

11.4 Material Quality Guarantee Errors

MESSAGE CAUSE

Support (or build) | Modeler is out of material bottles, a bottle misfed, or
material bottles the material identification system is faulty.

not detectedd

Support (or build) = A cold bottle was added to the material delivery system
material bottle not = and it did not have enough time to melt before the

melted modeler requested material.

Support (or build) | The material identification system detected expired

material bottle material.
expired

Support (or build) | A material bottle was inserted into the wrong feed slot.

material bottle
incorrect type

11.5 Material Waste Errors

MESSAGE

RT_ERROR: draintank not
responding

RT_ERROR: Draintank
Position error

RT_ERROR: Draintank
timeout error

RT_ERROR: can't empty
draintank

CAUSE

Fault detected in control
circuitry.

Fault detected in control
circuitry.

Fault detected in control
circuitry.

Sensor or valve
malfunctioned.

ACTION

Hotline.

The build will abort if it needs to use the questionable bottle to
finish the build.

® Add the specified material bottle, install a clean build
platform and repeat the build job.

® |f error message occurs again, contact your Technical
Support Hotline.

The build will abort if it needs to use the questionable bottle to
finish the build.

® |Install a clean build platform and repeat the build job
after the modeler has reached build temperature.

® |f error message occurs again, contact your Technical
Support Hotline.

Follow the discard instructions posted to the LCD panel.

The build will abort if it needs to use the questionable bottle to

finish the build.

® Follow the discard instructions posted to the LCD
panel.

® |f error message occurs again and you have inserted
the correct material bottle into the correct feed slot,
contact your Technical Support Hotline.

ACTION

Cycle power to the modeler.

Technical Support Hotline.

Cycle power to the modeler.

Techncial Support Hotline.

Cycle power to the modeler.

Techncial Support Hotline.

Cycle power to the modeler.

Techncial Support Hotline.

If error message occurs again, contact your

If error message occurs again, contact your

If error message occurs again, contact your

If error message occurs again, contact your



11.6 Motion System Errors

MESSAGE CAUSE ACTION

X-Following = An attempt to open the build chamber door Ensure the build chamber door is secured, then cycle power to the modeler. If
ERROR was made, or position sensor errors occurred. = error message occurs again, contact your Techncial Support Hotline.
Negative Variations in scanning axis velocity. Cycle power to the modeler. If error message occurs again, contact your
Firing Technical Support Hotline.

Delay

Pause Position sensor contamination. Cycle power to the modeler. If error message occurs again, contact your
Timeout Technical Support Hotline.

ERROR

11.7 UV Subsystem Errors

MESSAGE CAUSE ACTION
RT_ERROR: UV UV sensor Cycle power to the modeler. If error message occurs again, contact your Techncial Support
Lamp Power Too detected a Hotline.
Low possible fault.
CAUTION

To prevent skin exposure to uncured model material, do not handle parts in
a build without wearing gloves if a UV lamp problem occurred during the

build.
11.8 Vacuum Regulator Errors
MESSAGE CAUSE ACTION
RT_ERROR: Printhead Indicates a fault within the Cycle power to the modeler. If error message occurs again, contact your
Vacuum Low vacuum system. Techncial Support Hotline.
RT_ERROR: Printhead Indicates a fault within the Cycle power to the modeler. If error message occurs again, contact your
Vacuum High vacuum system. Techncial Support Hotline.

11.9 Power Outage

If you are present during a power outage, or discover the main power OFF, complete the following steps:

1. Switch power OFF on modeler's rear panel so it does not automatically start when power is restored. This prevents modeler damage due
to power flickers and surges.

1. When power is restored and stable, switch modeler power ON located on the rear panel.

Power Switch

If power outage occurs and is restored before anyone can take action, the modeler will recover as follows:



The modeler advances through warming stages until reaching the required build temperatures. If modeler was not building when power outage
occurred, the top line on the LCD panel will display "Not Building" and bottom line will display "Online/Menu?". The modeler is ready to
accept a build job.

If modeler was building when the power outage occurred, the LCD panel will display "Power Off Recovery" after power is restored and modeler
has reached build temperature. This safety feature prevents accessing incomplete build until all build conditions are satisfied. Once occurred, the
job will end, the LCD panel will display "Done Remove Build" and the build platform will move forward, and can be removed and repeat build
job if desired.

If the modeler is in Power Off Recovery, the build
chamber will not be able to open until modeler
completes recovery.

12.0 Finishing

When the build is complete, refer to the VisiJet® Material Handling and Post-Processing Guide for information on how to detach parts from build
platform, remove support material from parts, and clean parts to a smooth finish. Basic part coating and equipment maintenance
recommendations are also included.

13.0 Projet™ Spare Parts List

® 13.1 Consumables and Replacement Modules

13.1 Consumables and Replacement Modules

To view the parts and modules that are available, click on the Projet™ Spare Parts Locator.

14.0 Other Documents

14.1 Parts Finisher User Guide

14.2 Material Safety Data Sheets (MSDS)

14.3 Projet™ Quick Reference Guide

14.4 Facility Requirements Guide

14.5 VisiJet® Material Handling and Post-Processing Guide


http://3dWorks.3dsystems.com/display/VJHG/Table+of+Contents
http://3dWorks.3dsystems.com/display/ProJetCPCPXSPL/Select+a+Method+to+Find+Part

The documents listed are available to help guide you in how to finish parts, detailed safety information pertaining to the Visijet® materials, and
also, printer's dimensional data. Refer to these documents for specific instructions previously stated.

14.1 Parts Finisher User Guide

When the build is complete, refer to the ProJet™ XL Finisher Guide for information to detach parts from build platform and how to remove support
material and clean parts to a smooth finish.
Basic part coating and equipment maintenance recommendations are also included.

14.2 Material Safety Data Sheets (MSDS)

TO obatin a copy of the Material Safety Data Sheet (MSDS) or a Safety Data Sheet (SDS), click here.

14.3 Projet™ Quick Reference Guide

Click on the link to download a copy of the ProJet™ 5000 Quick Reference Guide.

ProJet™ 5000 Quick Reference Guide

14.4 Facility Requirements Guide

Projet™ 3-D Modelers Facility Requirements Guide

14.5 VisiJet® Material Handling and Post-Processing Guide

VisiJet® Material Handling and Post-Processing Guide

15.0 Service and Support

® 15.1 Contacts

15.1 Contacts

For information, questions, or comments about ProJet™ 3-D modeler system(s), VisiJet® materials, or request service, please contact a
3D Systems Customer Service or Sales Representative nearest you.

3D Systems

333 Three D Systems Circle
Rock Hill, SC 29730 USA

tel: 803.326.3900

email: moreinfo@3dsystems.com
www.3dsystems.com

Nasdaq: TDSC

Customer Support Hotline
U.S.A. 800.793.3669
Asia-Pacific (+852) 29 23 50 77
Europe (+49) 6151 357-0

Sales and Service

FRANCE tel (+33) 1 60 87 88 77 ITALY tel (+39) 039 68904 00


http://www.3dsystems.com/services/materials/index.asp#visijet
http://3dWorks.3dsystems.com/download/attachments/65732681/316131-04_PJ5000+Quick+Reference+Guide.pdf?version=1&modificationDate=1329228594920
http://3dWorks.3dsystems.com/pages/viewpage.action?pageId=11698237
http://3dWorks.3dsystems.com/display/VJHG/Table+of+Contents
http://www.3dsystems.com/

GERMANY tel (+49) 6151 357-0 JAPAN tel (+81) 3 5451-1690
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16.1 Frequently Asked Questions (FAQ)

General

What is rapid prototyping?
Rapid prototyping (RP) is the process of building a part from a 3D Cad drawing and converting the drawing format into an .STL file. When the

printing event takes place in the printer, it is constructed layer by layer using VisiJet® materials.

What is 3D Printing?

A type of rapid prototyping, typically defined by faster, more affordable, and easier-to-use technologies.

How does 3D Printing fit into the design process?

For a growing segment of designers using 3D CAD drawing, the ProJet Printer is quickly becoming an essential extension of overall CAD systems
and a critical part of the entire design process by:

® Accelerating Time to Market - through shortening design and development cycles and ultimately get products to market more quickly
enabling users to easily fine tune design and explore multiple design configurations.

® Generating Savings - by helping companies significantly lower production costs and reducing expensive revisions late in the development
cycle.

® Enhancing Communication and Collaboration - through bringing ideas off flat screens and producing functional 3D prints that can be
easily shared, critiqued, and improved upon.

® Creating Better Designs - designers are no longer limited to the number of models they can produce and test, resulting in more creative
designs and better final products.

® Ensuring Confidentiality - eliminating the need to exchange confidential design files with service providers, allowing companies to
maintain product confidentiality and control.

How does the 3D printing process work?

The printer builds functional 3D prints from the bottom up, one layer at a time.

STL files are imported into the printer that automatically slices and orients the parts and creates any necessary support structures. The materials
are fed into the printer in a heated semi-liquid state and accurately deposited in layers upon the build platform. After completion of the build,
support structures are simply removed through a post curing process.

How durable are the build material?

VisiJet® materials create accurate, detailed, and durable prints from your 3-D CAD designs. Popular applications include concept models, casting
forms, prototype parts, and specialty tools. All the specific physical and process characteristics of VisiJet materials are detailed in

Is post-processing required?



Yes, upon removing the part from the printer you will need to remove the support material from VisiJet® parts. The parts finisher makes removing
bulk support material from VisiJet parts efficient and easy. Forced airflow and precision temperature control deliver faster, shorter, and more
predictable VisiJet part finishing times.

Are there any special facility requirements or operating systems necessary to install and operate the printer?
Refer to the ProJet™ 3-D Printers Facility Requirements Guide.

Can more than one user process files and build parts?

Multiple users can send files to the printer build queue, move, delete, and set build priorities in the build queue. Depending on the size of the print,
multiple files can be added onto the build platform in one build application.

Can prints be sanded, painted, dyed, and glued?

The parts can be sanded to remove imperfections or layer lines from the surface. After priming, the parts can be painted using any oil- or
water-based paint that is compatible with the primer, or you can dye VisiJet parts with candle-craft dyes. You can also use super glue to join parts
together.

What is Computer-aided design (CAD)?

Computer-aided design (CAD) is use of a wide range of computerbased tools that assist engineers, architects and other design professions in
their design activities. It is the main geometry authoring tool within the Product Lifecycle Management process and involves both software and
sometimes special-purpose hardware.

What is a .STL file?

A .stl file is a format used by Stereolithography software to generate information needed to produce 3D prints on Stereolithography machines. It is
a triangular representation of a 3-D object. The surface of the object is broken into a logical series of triangles. These triangles represent the
surface of the object.

How do | export an STL file from my 3-D CAD program?

Most CAD software offers STL conversion add-ins.

Are the build platforms reusable?

Yes the build platforms are reusable.

How many builds can one material bottle produce?

This depends on the size and the complexity of the part being built.

If material runs out before the print has completed the build process, does the build abort?

Yes the build will be aborted. Ensure that there is sufficeint amount of materials to complete the build.

When submitting a build, will the 3-d printing client software inform me if the amount of material is sufficient for
completing a build?

The client software will tell you how many bottles of material will it take to complete the build.
How do | order parts?

To order replacement parts you will need to contact 3D Systems' Customer Support.

16.2 Getting Help

This section provides quick access to operating, maintenance, troubleshooting, and contact information to 3D Systems Customer Support
Centers.

® Material Safety Documentation
® Contact 3D Systems Corporation

16.3 Part Material


http://3dsystems.com/services/materials/index.asp#visijet

Part Material Safety Guidelines

Material Disposal
Material Handling
Material Safety
Material Usage
Spilled VisiJet Material
Waste Removal

16.4 Printer Hardware and Installation

This section describes the modeler setup appications and functions.

Client Hardware & Network Interface
Electrical

® Electrical Safety
® General Safety Guidelines

Ultraviolet (UV) Safety
Unpacking Printer

Network and System Setup
Installing Material Cartridge
Installing & Removing Build Platform
Build Process & Previewing Build
Printer Status

Abort Build

Part Removal

Shutting Down System
Notification Messages

Return Printer for Repair

16.5 Facility Requirements

The requirements for electrical and room preparation are specified in the Projet™ 5000 Facility Requirements Guide.

17.0 Glossary of Terms

Build Material - is a paste-like acrylic compound that is an ultraviolet (UV) curable material.

Build Platform - this part is used by the printer to build parts. Support structures link the print to the build platform and must be removed from the
printer once complete.

Chamber Door - the chamber door prevents harmful UV radiation from escaping the build chamber during the build process. The chamber door
must be closed prior to starting or resuming a build job and is locked when a build is in progress.

Debug Log - is a text file used for obtaining information for resolving potential problems that may occur with the printer.

Job Scale Percentage (Job Scale %) - is used to resize parts during the build process.

Material Delivery Module- stores and feeds the material to the printer during the build process. Each material delivery module (MDM) can hold
one (1) bottle of material. The printer can be equipped with four (4) build side MDMs and up to four (4) support side MDMs.

Material Quailty Guarantee - the printer reads an encrypted RFID tag on the cartridge to communicate parameters and ensure optimum build
quality.

Modeling - the printer uses materials and a build platform to create 3-dimensional plastic prototype prints.

Operator Panel - is used to display build job status, menu options, and command prompts for the printer.

Post Curing (Finishing) - is the final process to remove support material from parts and clean the parts to a smooth finish prior to surface finishing
and coating.

ProJet Client Software - is used to setup, run, and manage build jobs.

Shrink Comparison Percentage (Shrink Comp %) - is used to adjust for expected shrinkage during the build so actual part dimensions more
closely match actual dimensions.
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.stl File -- is a 3-dimensional solid Computer-aided design (CAD) software system used to produce prints.

Support Material - is a wax based material that provides adhesion to the build paltform and support for down facing surfaces and open volumes
within the print.

Waste Material - is any uncured support and/or build material generated during a build process.
X-Axis - is the orientation of the part from front to rear on the build platform.
Y-Axis - is the orientation of the part from left to right on the build platform.

Z-Axis - is the orientation of the part height on the build platform.
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